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1.0 Employment Opportunities Plan Background 
 

In support of the Commonwealth’s commitment to inclusion, each July 1 agencies are required 

to submit a formal Employment Opportunities Plan (EOP) that outlines strategies for increasing 

the employment of individuals with disabilities.  

The Employment Opportunities Plan should highlight progress achieved towards the strategies 

used for expanding and increasing opportunities for individuals with disabilities, to include: 

internal policies and practices, recruitment efforts, interviewing criteria, and resources to 

accommodate applicants and workers with disabilities.  

To assist agencies with this objective, and to align with other workforce planning and 

development initiatives, DHRM has created the Employment Opportunities Plan template. This 

Excel based template provides a walkthrough of how an agency can create an Employment 

Opportunities Plan by examining key workforce metrics, analyzing both internal and external 

environmental factors, and outlining strategy objectives and action items.   

Using the Excel based template allows agencies to then import their Employment Opportunities 

Plan directly into their full Workforce Planning and Development annual plan, promoting 

efficiency and alignment of workforce planning and development efforts.  
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2.0 Employment Opportunities Plan Template  
 

The Employment Opportunities Plan Template is an Excel based template and can be found on 

the DHRM Website.  

The template provides a structured approach to creating the Employment Opportunities Plan. 

Though it is based in Microsoft Excel, it is not designed as a traditional workbook or worksheet. 

The template is organized by grouping key information on various tabs, indicated at the bottom 

of the template, which builds upon previous tabs.  

• Home - The Home tab is a central place for users to navigate to the different tabs, track 

their progress of each step, and to see what version of the template is being used. 

• Getting Started – The Getting Started tab reviews important features, setup, and 

instructions for using this template to its full potential. It is highly encouraged for users 

to review this tab. 

• Agency Profile – The Agency Profile includes the overall agency information required to 

utilize the template, to include the agency name, secretariat, and agency number. An 

optional logo can also be added here. The Agency Profile also includes overall workforce 

information related to the Employment Opportunities Plan. 

• Workforce Data – The Workforce Data tab identifies specific elements for agencies to 

interpret data from their current workforce that relate to their EOP. 

• Agency Strategy – The Agency Strategy tab guides agencies through a SWOT Analysis 

exercise to interpret the current environment and utilize that, along with workforce data, 

to create an action plan, provide updates, or modify an existing plan. 

• EOP Summary – The EOP Summary tab compiles the information from the Agency 

Profile, Workforce Data, and Agency Strategy tabs into a single, easy to read report. 

 

The template also uses a series of Excel Macros, specific procedures that can automate 

processes, to increase the template’s functionality and ease of use. Macros must be enabled in 

order to use these functions. However, the template is also designed so that it can be used 

without Marcos if an agency wishes, but would requires some manually steps when completing 

specific sections. More information on the design on the template are reviewed in the “Getting 

Started Tab” section. 
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3.0 Workforce Planning Data Definitions 
 

The Employment Opportunities Plan aligns with the Workforce Planning and Development 

report agencies submit annually. To further promote alignment, definitions for specific data 

metrics are outlined in the Workforce Planning Data Definitions document on the DHRM 

Website.  

The Employment Opportunities Plan includes data elements defined in both the General 

Definitions and Employment Opportunities Plan Template sections of the data definitions 

document. 

Please review the data definitions document for specific definitions as needed.  
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4.0 Tab Guides 
 

The Employment Opportunities Plan template is divided into several tabs that house similar 

information. It is recommended for users to progress through the tabs from left to right, 

beginning with the Home Tab. 

Home Tab 
The Home tab is a central place for users to see a description of and navigate to the different 

tabs, track their progress of each step, and to see what version of the template is being used. The 

version number is located in the bottom right corner of the home tab, and is represented by the  

icon. 

Each of the tab names, highlighted in blue, are hyperlinks to the tabs. Click on any of the names 

to navigate to the respective tab. 

To being using the template, click on the “Getting Started” Tab name in blue.  

 

 

 

Getting Started Tab 
The Getting Started tab reviews important features, overall setup, and some instructions on how 

to begin using the Employment Opportunities Plan template. Though it is not required to review, 

it is highly recommended users spend time to review this information.  

The tab begins with a quick overview and description of the contents.  

Blue Name of 

the Tab is a 

Link to the 

Respective Tab 

Progress bar 

Shows Step 

Completion 

Version 

Number of the 

Template 
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Step 1: Review Overall Setup 

The Getting Started tab provides a breakdown of the overall setup for the remaining tabs. Each 

tab follows the general setup of having the step number and title on the left hand side, a set of 

instructions underneath, and the required data to be entered labeled (either above or to the left).  

Cells with a yellow background indicate required information to be entered. Once all the 

required information is entered, the step indicator will change from Incomplete to Complete. 

 

 

 

 

 

 

 

 

Some steps may include sub steps, indicated by the step number and letters slightly indented 

from the left.  

 

Step 2: Review Important Features of This Tool 

The Getting Started tab provides a breakdown of the important features of the template, used to 

assist with entering and interpreting workforce information. Below are descriptions of the 

template’s key features.   

 

 

 

 

USE OF EXCEL MACROS 
 

This template utilizes a series of Excel macros, which are custom 

actions used to automate specific tasks. This template performs best 

when using Excel 2016 or later. NOTE: Excel Macros must be 

enable to use them. The template can also be used without the 

Macros, but will require some manual edits. 

 

 

 

 

 

 

 

EASY FILE NAVIGATION 
 

Each Excel Worksheet, or tab, houses related information which is 

compiled together into a single report. Links to each tab are frozen 

at the top of each tab to easily navigate between them. 
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COLOR CODED DATA ENTRY 
 

Colors are used to identify what data should be entered and where. 

Yellow indicates required information. Green indicates optional 

information, and Gray indicates information is not required. 

 

 

 

 

 

BUILT-IN HELP FEATURES 
 

This template has a built in help feature. Click on the question mark 

in the blue circle to open a window with additional information, 

definitions, and steps to complete. NOTE: Macros must be 

enabled. The template cannot be edited while help windows are 

open. 

 

 

 

 

 

 

PROGRESS INDICATORS 
 

The home tab provides progress indicators for each step of the 

template. Each tab also provides progress indicators for each step or 

sub-step, which show if the step is complete or incomplete. 

 

 

 

 

 

 

DATA IMPORT 
 

This template is part of a suite of integrated workforce planning and 

development tools. Using these tools allows for information to 

easily be imported from one tool to the next. Data cannot be 

imported unless using a specific template, provided by DHRM upon 

request. NOTE: MACROS MUST BE ENABLED TO UTILIZE 

THIS FEATURE. 

 

EASILY REVIEW PRIOR INFORMATION 
 

This template, if the prior year information as imported, has select 

areas of the template that allow for easy viewing of the prior year 

responses, noted by the magnifying glass icon in the blue call out 

bubble. NOTE: MACROS MUST BE ENABLED TO UTILIZE 

THIS FEATURE. 

 

 

 

 

 

 

TEMPLATE VERSIONS 
 

As we continue to enhance this template, integrate it with other 

elements of workforce planning and development, or as changes to 

any mandates or guidance occurs, new versions of this template may 

be released. The version number is located on the Home tab in the 

bottom right corner.  

 

It is important to be using the most up to date version, which will be 

noted on the DHRM Workforce Planning Website. As new versions 

are released, the prior version data can be imported so no progress is 

lost.  
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(Optional) Step 3: Enable Macros to Utilize Full Functionality 

To ensure Macros are enabled, when first opening the file or anytime the filename changes, you 

will see a “Security Warning” at the top (shown in the picture below) indicating Macros have 

been disabled. Click the “Enable Content” button to enable macros for the file. 

 

 

(Optional) Step 4: Import Data from Other Sources 

For efficiency and integration to other workforce planning and development tools, data from the 

Prior Year Employment Opportunities Plan can be imported. Imported data, shown in the table 

below, will automatically enter the information into the respective cells. Agencies are 

encouraged to still review the information for accuracy. 

Agency Profile Workforce Data Agency Strategy 

Agency Name 

Overall Workforce Data 

Hiring Information 

Applicant Information 

Internal Promotions 

Internal Transfers 

Voluntary Separations 

External Transfers 

SWOT Analysis 

Response (view only) 

Strategy Objectives and 

Action Items 

 

To import the data, click on the Import Data Icon  for the tool the data is imported from.   

 

This will open the standard “Open File” dialog box. Simply locate and select the Prior Fiscal 

Year EOP template and click “Open”. (Shown in the picture below).  

 

Click to Enable Macros 

1. Select Prior Year EOP Template 

2. Click Open 
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If the data is imported successfully, the template will indicate the date and time the data was 

imported (shown in the picture below).  

 

If the data import was unsuccessful, the dialog box (in the picture below) will indicate an error 

occurred and to contact DHRM Workforce Planning at dhrm.wfp@dhrm.virginia.gov.  

 

 

Agency Profile Tab 
The Agency Profile Tab of the Employment Opportunities Plan is a condensed version of the full 

Workforce Planning and Development Agency Profile. It includes some general information, 

such as the agency name secretariat, agency number, and overall workforce data essential to the 

Employment Opportunities Plan. 

 

Step 1: Enter Agency Information 

To complete step one, entering agency information, select the agency name from the drop down 

menu in the yellow box (shown in the picture below). To show the dropdown arrow, click in the 

yellow cell. The secretariat and agency number will be displayed automatically 

An optional logo can be added by clicking the “Insert Logo” purple button, selecting the logo 

picture file, and then resizing the image to be within the green outlined box.  

 

1. Click on Arrow 

to See Dropdown. 

2. Select Agency 

from Dropdown.  Click the purple button to 

add an Optional Agency Logo 

(instructions below) 

mailto:dhrm.wfp@dhrm.virginia.gov
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To add an optional Agency Logo, click on the purple button to open the standard “Open File” 

dialog box. Simply locate and select the Agency Logo and click the “Open” button. NOTE: The 

Agency Logo must be a picture file. 

 

 

 

Once added, resize the logo to be within the green outlined box (shown in the picture below) by 

clicking the “Resize: OFF” purple button. After the Image is resized to be within the green box, 

click the “Resize: ON” button.  

Before 

 

 

 

 

 

 

After 

 

 

 

 

 

1. Select the Agency Logo 

2. Click Open 
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Step 2: Identify if the Summary is for the Fiscal Year Submission or as a Snapshot in Time. 

To complete step 2, select whether the agency is using the template to complete the mandated 

fiscal year employment opportunities plan or to take a workforce snapshot from the dropdown 

menu in the first yellow box.  

Next, enter the date of the end of the fiscal year (if using the template for the fiscal year 

submission) or the date of the snapshot.  

 

 

Step 3: Enter Classified Workforce Information 

To complete step 2, enter the total number of classified employee and total number of employees 

with disabilities for each fiscal year in the yellow boxes below outlined in red (shown below). To 

enter the data, click on the respective cell and then enter the number.  

 

 

 

 

 

 

 

 

Next, enter the total number of employees with disabilities for each fiscal year who are leaders 

(defined as individuals with 2 or more direct reports) and who are executives (defined as the 

agency head and their direct reports) in the respective yellow boxes outlined in red.  

 

 

 

 

 

 

 

1. Enter the total 

number of classified 

employees and total 

number of classified 

employees with 

disabilities  

2. Enter the total 

number of classified 

employees with 

disabilities who are 

leaders or executives 

Click for 

Help if 

needed 

1. Select the 

type from the 

dropdown 

menu.  
2. Enter the date 

(MM/DD/YYYY) 

format.  
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Next, enter the number of classified veterans with disabilities, veterans with disabilities who are 

leaders and those who are executives for each fiscal year in the yellow boxes outlined in red 

below.  

 

  

3. Enter the total 

number of classified 

veterans with 

disabilities, those who 

are leaders and those 

who are executives 
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Workforce Data Tab 
The Workforce Data tab guides agencies by identifying the key metrics included in the 

Employment Opportunities Plan, specifically recruitment and retention information. Data entered 

here feeds into a brief Workforce Insights tool on the Agency Strategy tab and into the overall 

EOP Summary.  

Data entered into the Workforce Data tab should reflect Classified Employees only for July 

1st through May 31st of the reporting fiscal year. 

 

Step 1: Enter Classified Employee Recruitment Information 

To complete step 1, enter the classified hiring and applicant information for the agency in the 

yellow boxes outlined in red for each fiscal year. These include the total classified hires, total 

classified applicants, and a breakdown of classified hires and applicants who were employees 

with disabilities (shown in the picture below).  

 

 

 

 

 

 

 

 

 

 

Agencies should also enter the total number of employees with disabilities hired to leader or 

supervisory roles (defined as individuals with 2 or more direct repots) and executive roles 

(defined as the agency head and their direct reports), as well as applicants with disabilities to 

both leader/supervisory roles and executive roles, for each fiscal year in the yellow boxes 

outlined in red (shown in the picture above. 

 

Step 2: Enter Alternative Hiring Process (AHP) Information 

To complete step 2, enter the specific information regarding the alternative hiring process, which 

launched in April 2022, to include the total number of individuals who applied using this 

process, the total hired from this process, and the total employees of those hired with this process 

who transitioned to a classified position in the yellow boxes outlined in red (shown below). 

Click for 

Help if 

needed 

1. Enter the total 

classified hires and 

total classified hires of 

employees with 

disabilities for each FY 

2. Enter the total 

classified applicants 

and total classified 

applicants of employees 

with disabilities for 

each FY 
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Step 3: Enter Classified Employee Retention Information 

To complete step 3, enter the classified retention information in the yellow boxes outlined in red 

for each of the respective categories: agency years of service, internal promotions, internal 

transfers, voluntary separations, and external transfers (to other state agencies). See the 

Workforce Planning Data Definitions for definitions of each. 

To enter the agency years of service, enter the average years of service for classified employees 

and classified employees with disabilities. Then, enter the average years of service for employees 

with disabilities who are leaders or supervisors (defined as individuals with 2 or more direct 

reports) and those who are executives (defined as the agency head and direct reports).   

 

 

 

 

 

 

 

Next, enter the number of internal promotions in the yellow boxes outlined in red below for 

classified employees and classified employees with disabilities. Then, enter the number of 

internal promotions of employees with disabilities who are leaders or supervisors (defined as 

individuals with 2 or more direct reports) and those who are executives (defined as the agency 

head and direct reports).   

 

 

 

 

Click for 

Help if 

needed 

1. Enter the total 

applicants and total 

hires from the 

alternative hiring 

process. Enter the 

total number of 

employees hired with 

AHP who transitioned 

to a classified position 

Click for 

Help if 

needed 1. Enter the average 

years of service for 

classified employees, 

employees with 

disabilities, and those 

who are leaders and 

executives for each FY 

2. Enter the internal 

promotions for 

classified employees, 

employees with 

disabilities, and those 

who are leaders and 

executives for each FY 
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Next, enter the number of internal transfers in the yellow boxes outlined in red below for 

classified employees and classified employees with disabilities. Then, enter the number of 

internal transfers of employees with disabilities who are leaders or supervisors (defined as 

individuals with 2 or more direct reports) and those who are executives (defined as the agency 

head and direct reports).   

 

 

 

 

Next, enter the voluntary separations in the yellow boxes outlined in red below for classified 

employees and classified employees with disabilities. Then, enter the number of voluntary 

separations of employees with disabilities who are leaders or supervisors (defined as individuals 

with 2 or more direct reports) and those who are executives (defined as the agency head and 

direct reports).   

 

 

 

 

Next, enter the external transfers (to other state agencies) for classified employees and classified 

employees with disabilities in the yellow boxes outlined in red below. Then, enter the number of 

external transfers of employees with disabilities who are leaders or supervisors (defined as 

individuals with 2 or more direct reports) and those who are executives (defined as the agency 

head and direct reports).   

 

 

 

 

 

Agency Strategy Tab 
The Agency Strategy tab first presents a quick analysis of the workforce data from the Agency 

Profile and the Workforce Data tab in the Workforce Insights section. This optional section can 

be used to assist with completing the Agency Strategy Tab (conducting the SWOT Analysis and 

creating the Strategic Action Plan).  

3. Enter the internal 

transfers for classified 

employees, employees 

with disabilities, and 

those who are leaders 

and executives for 

each FY 

4. Enter the voluntary 

separations for 

classified employees, 

employees with 

disabilities, and those 

who are leaders and 

executives for each FY 

5. Enter the external 

transfers for classified 

employees, employees 

with disabilities, and 

those who are leaders 

and executives for 

each FY 
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Optional – Review Workforce Insights Section 

The workforce insights section provides a brief review of the information entered on the Agency 

Profile and Workforce Data tabs to assist with completing steps 1 and 2 of the Agency Strategy 

tab. To adjust the graphics, click in the first yellow box labeled Fiscal Year and then click the 

gray down arrow to select a fiscal year. Repeat this for the demographic group.  

 

 

 

 

 

 

 

 

 

After Fiscal Year and Demographic Data is selected: 

 

 

 

 

 

 

 

 

 

 

 

 

The workforce insights section also displays key metrics related to the employment of 

individuals with disabilities and their change to the prior year. NOTE: These metrics reflect 

classified employees only. 

Select a Fiscal 

Year and 

Demographic 

Group from the 

Dropdown Menus 

using the arrow in 

the gray box 

Chart to show overall percentage 

and demographic group breakdown 

of employees with disabilities 

Chart to show internal mobility of 

employees with disabilities 

(promotions and internal transfers) 

Chart to show 

agency entry 

(applicants and 

hires) and exits 

(vol. separations 

and external 

transfers) of 

employees with 

disabilities 
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• Hire Rate: the total number of hires of individuals with disabilities divided by the total 

number of employees. 

• Candidate Hire Rate: the total number of hires of individuals with disabilities divided 

by the total number of applicants. 

• Internal Mobility Rate: the total number of internal promotions and transfers of 

individuals with disabilities divided by the total number of employees. 

• Vol. Separation Rate: the total number of external transfers and voluntary separations of 

individuals with disabilities divided by the total number of employees. 

Changes to each metric from the prior year are indicated by arrow icons and the percent change 

(shown in the picture below). 

 

▲ 
Indicates an increase from the prior year. 

▼ 
Indicates a decrease from the prior year. 

◄► 
Indicates no change from the prior year. 

 

Step 1: Complete a SWOT (Strengths, Weaknesses, Opportunities, and Threats) Analysis 

for the Agency Related to the Employment of Individuals with Disabilities 

A SWOT analysis (Strengths, Weaknesses, Opportunities, and Threats) is one of many tools 

organizations can utilize to reflect on their internal and external environments. See below for a 

description of each area of the analysis and some potential examples or items to review for each.  

Strengths Weaknesses Opportunities Threats 

Strengths are elements 

INTERNAL to the 

Agency (within the 

control of the Agency) 

that ENHANCE an 

Agency’s ability to 

achieve a goal 

Weaknesses are elements 

INTERNAL to the 

Agency (within the 

control of the Agency) 

that INHIBIT an 

Agency’s ability to 

achieve a goal 

Opportunities are 

elements EXTERNAL to 

the Agency (being out of 

the control of the Agency) 

that ENHANCE an 

Agency’s ability to 

achieve a goal 

Threats are elements 

EXTERNAL to the 

Agency (being out of the 

control of the Agency) 

that INHIBIT an 

Agency’s ability to 

achieve a goal 

Some Examples Include: 

Best Practices 

Successful Initiatives 

Access to Talent or 

Demographics 

Internal Expertise 

Policies or Practices 

Some Examples Include: 

Policies or Procedures 

Internal Processes 

Limited Positions 

Funding Sources 

Some Examples Include: 

Partnerships with Other 

Organizations 

Local Workforce 

Demographic Trends 

Expertise available 

Locally 

Funding Sources 

Some Examples Include: 

Limited Access to 

Organizations or Expertise 

Local Workforce 

Demographic Trends 

Funding Sources 
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To complete the SWOT Analysis, enter a brief, high level description of the items for each 

respective category (recruitment, retention, engagement, and development) in the yellow boxes 

outlined in red for Agency Strengths, Weaknesses, Opportunities, and Threats Section. Use the 

checkbox underneath to indicate there is nothing to enter.  

 

 

 

 

 

 

 

 

1. Enter a brief, high level, 

description of Strengths 

(pertaining to the 

employment of individuals 

with disabilities) for each of 

the 4 categories 

Click the checkbox if there 

are no items to enter 

2. Enter a brief, high level, 

description of Weaknesses 

(pertaining to the 

employment of individuals 

with disabilities) for each of 

the 4 categories 

Click the checkbox if there 

are no items to enter 

3. Enter a brief, high level, 

description of Opportunities 

(pertaining to the 

employment of individuals 

with disabilities) for each of 

the 4 categories 

Click the checkbox if there 

are no items to enter 
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To view prior year responses to the SWOT Analysis, click the magnifying glass icon (shown in 

the picture below) to display the responses from the prior year. NOTE: Prior responses will 

only be displayed in the prior year employment opportunities plan is imported. 

 

 

 

The prior year responses can be hidden again by clicking the same icon. 

 

 

4. Enter a brief, high level, 

description of Threats 

(pertaining to the employment 

of individuals with disabilities) 

for each of the 4 categories 
Click the checkbox if there 

are no items to enter 

Click the 

magnifying glass 

icon to show prior 

year responses. 

Click the 

magnifying glass 

icon to hide prior 

year responses. 
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Step 2: Create an Agency Strategy 

Using both the optional Workforce Insights section and SWOT Analysis, create a strategic action 

plan for addressing the recruitment, retention, engagement, and development of employees with 

disabilities.  

Each item should include an overall objective statement and then specific actions items to take in 

order to fulfill that objective. A total of 5 objectives can be added per plan and a total of 5 action 

items can be added per objective.  

If Not Using the Excel Macros, Skip to Step 2(a) 

To add an objective, click the purple “Add Objective Button”, this will show the objective 

description box.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Click the “Add Objective” to see 

Objective Entry Box (below) 

2. Enter the Objective Statement 

(brief) into the yellow box. 

3. Click the “Add Action Item” button 

to see the Action Item Entry box 

(below) 

4. Enter the Action Item 

in the Yellow Box 
5. Click the “Add Action Item” button again to 

add up to 4 more Action Items (Shown Below) 

Click for 

Help if 

needed 
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Action items can be removed by clicking the “Remove Last Item” purple button. This will 

remove the last action item that was added.  

 

 

 

 

 

 

 

 

 

 

 

 

 

If the prior year employment opportunities plan was imported, the prior year objectives and 

action items will be shown. These items can be modified, new items added, or a progress update 

provided.  

Items being modified will show a “Modified Indicator” (shown below). 

 

New items will show a “New” Indicator.  

 

To add a progress update, click the “Add Progress Update” purple button and enter the update, a 

few sentences, in the yellow box (shown below).  

 

 

 

 

Click to 

Remove Last 

Added 

Action Item 

1. Click the “Add Progress Update” to 

see Update Entry Box (below) 
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These steps should be repeated for any additional objectives (up to 5) added to the strategic 

action plan. In the event an objective should be removed, click the “Remove Objective” purple 

button. This will remove the objective and all action items.  

 

 

 

(Optional) Step 2(a): Create an Agency Strategy without Macros 

If the purple buttons were used to enter the Strategic Action Plan, this step can be skipped. 

In the event Macros are not being used, the Strategic Action Plan can be entered by first entering 

the total number of objectives and total number of action items for each objective in the green 

boxes.  

 

 

 

 

 

 

 Click to Remove Last Objective 

Added (will also remove all 

action items for that objective) 

1. Enter the 

Total Number 

of Objectives in 

the Strategic 

Plan 

Enter the date of the update 

and a summary of the progress 

update. 1. Click the “Remove Progress 

Update” to remove the update. 
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If any updates are being added to any of the objectives, select “yes” from the dropdown next to 

the objective the update is for (shown in the picture below). 

 

 

 

 

After the numbers are entered, click on the Filter Icon in cell W1 to show the filter menu (top 

right corner). Ensure there is no check box next to “0” (zero) and then click okay to filter the 

sheet.  

 

 

 

 

 

 

 

2. Enter the 

Total Number 

of Action Items 

for Each 

Objective 

NOTE: If there is no objective, 

the box will be grayed out and 

can be left empty 

4. Click the filter 

Icon to show 

filter menu 

3. Select “Yes” 

if a progress 

summary is 

included with 

the objective. 
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Scroll up on the sheet to see the entry boxes for all objective and action items. The objective and 

action item numbers can be changed using this same process. If the objective number decreases, 

ensure all grayed out cells for the action items are empty, otherwise the data will not filter 

correctly. 

 

(Optional) Step 3: Check Spelling 

The template allows for the spell check feature to be used on this tab, however, Macros must be 

enable to use this feature. Click the “Spell Check This Tab” purple button, which will launch the 

Excel spell check function.  

 

 

 

EOP Summary Tab 
The Employment Opportunity Summary Tab complies the information from the previous tabs 

into a single report. It begins with an overall summary and then displays graphics for key 

workforce metrics, the SWOT Analysis graphic (which can be omitted) and presents the Agency 

Strategy objectives and action items.  

At the top and bottom of the tab are indicators to show if the report is up to date or needs to be 

refreshed. Anytime items are added or removed from the agency strategic action plan, the report 

will need to be refreshed.  

 

5. Verify “0” is 

unchecked 
6. Click Ok 

1. Click Spell Check This Tab button to 

launch the Check Spelling function 
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The indicator will change to “Report is up to date” after refreshing the report.  

 

 

 

 

 

 

 

(Optional) Refresh Report without Macros 

If Macros are not used, the report can be refreshed manually by clicking the filter icon in cell 

“Z1” to show the filter menu (top right corner). Ensure there is no check box next to “0” (zero) 

and then click okay to filter the sheet. This will change the indicator to say “Report is up to 

Date”. 

 

 

 

 

If the report needs to be refreshed, click the 

purple “Click to Refresh Report” button 

1. Click the filter 

Icon to show 

filter menu 

Click for 

Help if 

needed 
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Step 1: Complete EOP Summary 

Before the report is exported, a few additional notes will need to be entered, to include an overall 

summary and notes for the SWOT Analysis, all of which are indicated by yellow boxes outlined 

in red below.  

 

 

Step 1(a): Enter Report Summary 

In the first section of the report, enter a summary in the yellow box outlined in red of key 

findings, prior actions to promote the employment of individuals with disabilities and their 

impact, and a brief discussion of the further actions that will be taken. The background will 

change to white once anything is entered into the cell.  

2. Verify “0” 

is unchecked 

3. Click Ok 

Click for 

Help if 

needed 
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Step 1(b): Enter Brief Overview and Notes for SWOT Analysis 

Enter an overall summary of the SWOT Analysis as well as notes for each of the four areas 

(Strengths, Weaknesses, Opportunities, and Threats) in the yellow boxes outlined in red on the 

SWOT Analysis to give additional context to the items outlined in the report.  

This step can be skipped if the SWOT analysis is omitted from the report. See the Optional 

settings on how to exclude the SWOT analysis on the report. 

 

 

 

 

 

 

 

 

 

 

1. Enter the Report 

Summary in the yellow box. 

1. Enter a brief summary of 

the SWOT Analysis. 

2. Enter notes regarding 

Strengths 

3. Enter notes regarding 

Weaknesses 
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(Optional) Optional Report Settings 

The report allows for agencies to adjust some settings for the report, to include adjusting the 

color scales of the speedometer chart, choosing to include or omit the SWOT analysis, and 

adding titles to objectives for the strategic action plan.  

In the blue column on the left side of the report, the settings can be changed. For the data 

metrics, change indicators are included by default but can be exclude from the report if desired. 

To change this setting, change the “yes” to “no” in the green box for the “optional: include 

indicators for changes to prior year” section of the optional settings blue column (shown in the 

picture below). 

 

 

To change the color values of the speedometer chart, enter the values in the green boxes in the 

blue column. The green boxes represent the maximum value of the red color and the maximum 

value of the yellow color. NOTE: The maximum value of the yellow color cannot be below 

5%. 

The default maximum value for the red area is 3.5% and the maximum default value of the 

yellow area is 5%. 

 

 

 

 

4. Enter notes regarding 

Opportunities 

5. Enter notes regarding 

Threats 

1. Change to “No” 

to exclude change 

indicators. 
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                             Before Adjustment      After Adjustment 

 

 

 

 

 

 

 

 

Colors for the key data metrics can be customized between green, yellow, red, or purple to 

highlight specific metrics. Colors for the metrics can be changed by selecting the color from the 

dropdown menu for the respective metric in the “Optional: Change Colors to Identify Key 

metrics” section. The metric and change indicator colors are separate from one another.  

If no color change is desired, the metric and change will be black text. To remove the color 

change, delete the color text.  

 

 

The next optional settings is to either include or omit the SWOT analysis from the report. By 

default, the SWOT analysis is included. To change this setting, change the green box under the 

“Include SWOT Analysis in Report?” optional setting in the blue column to “No”. After, click 

the purple “Refresh Report?” button to hide the SWOT analysis. 

 

Click for Help 

if needed 

1. Enter Max % 

Value of Red Color 

2. Enter Max % 

Value of Yellow 

Color 

1. Change box 

to “No” 

2. Click “Refresh Report” 

to hide SWOT Analysis 

Click the 

respective 

box and 

select 

desired 

color from 

drop down 

menu.  
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To change the setting back to including the SWOT analysis in the report, change the green box to 

“Yes” and click the “Refresh Report” purple button again. 

The final optional setting is to add additional titles to the objectives in the final report. To add a 

title, enter the title text into the green box in the blue column next to the objective to add the title 

should be added to.  

Before Title is Added 

 

After Title Is Added 

 

 

Step 2: Ensure the Report is Up to Date 

Using the same procedures as before, ensure the report is up to date by refreshing the repot using 

the purple Refresh Report button or refreshing the report manually.  

Step 3: Export the Report to PDF 

After the report is completed it can be exported as a PDF to be signed either electronically or by 

hand. To export the report, click the “Export Report to PDF to Sign”. This will open a dialog box 

to save the PDF using the standard process to save a file. The report can be viewed by going to 

the saved location and opening the file.  

Optional Step 3: Printing the Report to PDF (without Macros) 

If not using the Macros, the report can be printed as a PDF using the standard Excel print 

function. Go to the “File” menu, and select print. Ensure the printer is “Microsoft Print to PDF” 

and click “Print”. Choose the save location and click “Save”. The report can be viewed by going 

to the saved location and opening the file. 

 

 

1. Enter the Title Text 

into the Green Box 
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5.0 Submitting the Report to DHRM 
 

Please submit the signed PDF and the Excel Template file to DHRM Workforce Planning at 

dhrm.wfp@dhrm.virginia.gov no later than June 30th of the reporting fiscal year.  

Please include the Agency Name and the term “EOP” in the subject line. 

 

For Questions or Additional Assistance 

For questions or assistance with the template, please contact DHRM Workforce Planning at 

dhrm.wfp@dhrm.virginia.gov.  

 

 

 

 

 

 

mailto:dhrm.wfp@dhrm.virginia.gov

